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Overview

Overview
TCAM/NcEdit is an NC program file editor for Windows, completely rewritten and
feature enhanced from its DOS counter-part, the TDEDIT and SNCEDIT.
Its built-in DNC functionality is compatible with its DOS counter-part. All those
existing IO setup files (with the "IO" extension) can be used directly by NcEdit in
setting up the I/O devices. Users upgraded from the DOS version should have no
problem with their DNC transmission on TCAM/NcEdit.
Additional features are
!

Multiple files opening and editing.

!

Multiple session of DNC transmission support (up to 8 devices).

!

Back-plotting and NC Path Emulation (including drawing export).

!

Language switching between English and local language.

Limitations
Maximum lines per file = 2147483648 lines.
Maximum character per line = 250 bytes.
Maximum Open files = 15 files.
Maximum Simultaneous DNC transmission = 8 devices.
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The Screen Layout
TCAM/NcEdit employs the standard layout of an MDI construct. Along with the popup menu, there is a fixed toolbar on top of the frame window and a status bar at the
bottom. You can choose to hide the toolbars and the status bar by the menu
commands [View.Toolbars] and [View.Status Bar].

The Document Frame
TCAM/NcEdit creates a document frame for each opening text file. Each document
frame contains the following three panels:
Text Panel

Showing the text content of the document file (your NC program
files). It allows you to edit the text contents. This panel is always
visible and appears at the top-left of the document frame.

Path Panel

Showing the resulting path emulation drawing based on current
text content of the NC program. It allows you to verify the NC
program in a direct and convenient way. The path emulation
serves as a fool-proof feature that prevents the operators from
sending wrong program files to the NC controller. On the path
panel, you can pick at a specific path segment to locate the
corresponding NC block for fast program editing. You may also
utilize the path backplotting which is being generated during data
transmission for on-line monitoring.
The path panel is activated upon user request and is available
only when the text document contains a valid NC program file for
selected emulator. When it is visible, it always appears at the
top-right of the document frame. A vertical panel slider is
provided for you to adjust its size within the frame.

Console Panel

This is the text display panel at the bottom of the document
frame. It is used to display the information and messages
pertaining to the document file. When both the Text and Path
panels are present, you can click the right mouse button at the
console panel and choose to dock this panel to the right, to the
left or totally to the bottom of the document frame. You can also
record the information and messages in a recording buffer and
save them to external text files.
A horizontal panel slider is provided for you to adjust its size
within the frame.

The following figure is an example of the document frame.
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The Menus
The standard menu of TCAM/NcEdit can either be in English or in your local
language, depending on current state of language usage.
The following sections describe the function provided by the pop-up menu, in the
order from left to right:

The File Menu
File

Each menu item is described in detail as follows:
New

Create a new NC program file. A blank document window
will be created.

Open...

Open an existing NC program file. You will be asked to
select the NC file from the pop-up file window and a new
document window will be created for it.
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Save
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Close the active NC program file. If the file content has been
altered, you will be prompted to save it before closing it.
Save the active NC program file. The disk file will be
updated. If this is a new file, you will be asked to enter the
filename from the pop-up file window. The window is not closed
after saving the NC file to disk.

Save As...

Save the active NC program file with a new name. The file
window will pop up for you to enter the new file name to save,
which will become the name of this document window.

Export...

Export the emulation result of the NC program file in various
kinds of drawing file format. You will be asked to enter the name
of the drawing file to export from the pop-up file window. You can
select one of the following drawing formats from the file-type
selection box:
WRK -- TwinCAD Work Drawing File.
DWG -- AutoCAD Drawing File (R10/R12).
DXF -- AutoCAD Drawing Exchange File (ASCII/Binary).
WMF -- Windows Meta File.
BMP -- Windows Bit-Map File.
GIF -- CompuServe Graphic Interchange Format.
PCX -- Paint Brush Picture File.
TIFF -- Tagged Image Format File.
See Exporting Emulation Results for details.

Merge...

Merge in an existing text file. You will be asked to select the text
file from the pop-up file window. The file will be read into current
active document window and merged into the text file before the
current text line where the text cursor (caret) is.

Save Selected... Save selected part of text lines to file, effective only when there
are texts in selection. You will be asked to enter the filename to
save by the pop-up file window. Note that the selected texts are
saved by lines. That is, if a text line is partially selected, the
whole line will be saved.
Print...

Print the active text file or the NC path emulation result,
depending on which is currently active. The Windows common
print dialog will pop up for you to conduct the printing action.

4

Print Preview

Display full pages of printouts.

Print Setup...

Change the printer and printing options. See The Print Setup
Dialog.

Exit

Quit the application. NcEdit will prompt to save documents if they
have been altered.
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The Edit Menu
Edit

Each menu item is described in detail as follows:
Restore Line Restore the original text content of the current line. When you move
the caret to a new text line before making any modification, its content will be saved
into a temporary buffer. You can restore it back after the text line is modified and
before you move the caret out of the line.
Cut

Cut the selection and put it on the Clipboard. Note that you
can not cut the text if its total size is greater than 64 KB (a
Windows limitation). If you need to transfer a large part of the text
lines to another NC program file, use [File.Save Selected...] and
[File.Merge...] instead.

Copy

Paste

Copy the selection and put it on the Clipboard. Note that you
can not copy the text if its total size is greater than 64 KB (a
Windows limitation). If you need to transfer a large part of the text
lines to another NC program file, use [File.Save Selected...] and
[File.Merge...] instead.
Insert text lines from Clipboard at current cursor position.

Delete

Erase the current text in selection.

Select All

Select all text lines in the file.

Find...

Find the specified text. A dialog box will pop up for you to
conduct the text searching. See Finding Specific Text for details.
You may also directly enter the text to find by using the FindText
combo-box from the toolbar.
You may press the

to continue the search for the text string

forward.
You may press the

to continue the search for the text string

backward.
The text cursor will appear at the beginning of the text that
matches.
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Replace...

Replace specific text with different text. A dialog box will pop up
for you to conduct the text searching and replacing operation.
See Replacing Specific Text for details.

Re-number...

Regenerating the sequence number of NC blocks. A dialog box,
as given below, will pop up for you to specify the starting number,
increment value, and number of digit to generate for the
sequence number.

If there are texts in selection, the regeneration is effective only to
those text lines in selection. Otherwise, the whole text lines will
be checked for the sequence number regeneration.
De-number

Remove the sequence number of NC blocks. If there are texts in
selection, the removal applies only to those text lines in selection.
Otherwise, the whole text lines will be checked for the sequence
number removal.

Read Only

Toggle the active file's read-only status. If a file is marked
ReadOnly, it will be protected against any modification thereafter.
You can open a file in ReadOnly mode, and change its status
anytime by this menu item.

The View Menu
View

Each menu item is described in detail as follows:
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Goto Line...

Goto specific line by line number. See Locating Specific Line.

Set Bookmark

Bookmark current line. A bookmark indicator will be placed
before the current line to indicate its position. When an emulation
path is present on the path panel window with Locate Mode
setting, then the corresponding NC code line to the located path
segment will also be bookmarked. See also Locate Mode
Operation.

Goto Bookmark

Goto the line being bookmarked.

Switch Bookmark

Switch the bookmark between the current line and the last
bookmarked line.

Toolbar

Show or hide the toolbar.
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Status Bar

Show or hide the status bar.

Text Console

Show or hide the console panel specific to the current document.

Local Language Switch to local language. If the local language (other than English)
is supported (both by the Windows and NcEdit), this menu item
will be enabled and you may switch to the local language by this
menu item.

The Transmission Menu
Transmission

Each menu item is described in detail as follows:
From bookmark Option to start sending data from line being bookmarked. If this
option is checked, the next data sending operation will start from
the bookmarked line. Note that if a data transmission activity is
interrupted, the line being interrupted will be bookmarked and this
option will be checked automatically.
Send to

Send the NC file to an external device. You can choose one of
the devices from the cascaded sub-menu. The devices must be
well setup before activating this function.

Receive from

Receive an NC file from the external device. You can choose one
of the devices from the cascaded sub-menu. The devices must
be well setup before activating this function. The current NC file
will be overwritten by the content received from the external
device.

Add new device...

Add New I/O Devices. See Setting up the I/O Devices for
details.

Modify device

Modify a specific device setup. You can choose one of the
devices from the cascaded sub-menu to modify. See Setting up
the I/O Devices for details.

Remove device

Remove an existing device setup. You can choose one of the
devices from the cascaded sub-menu to remove.

Stop...

Stop current DNC transmission of the active file, effective only
when a DNC transmission is being conducted on that particular
file.

Pause...

Pause the DNC transmission of the active file, effective only
when a DNC transmission is being conducted on that particular
file.
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The Emulation Menu
Emulation
Paths...

View the NC toolpaths (backplotting). If the document is a valid
NC program file, the path panel will be active to show its program
path. This is a very useful feature in verifying the NC program file
before sending it to the machine.

See NC Program Emulation on the Path Panel
Lathe ...

CNC Lathe emulation of the program (optional).

Milling ...

CNC Milling emulation of the program (optional).

Puncher ...

CNC Puncher emulation of the program (optional).

LaserCut...

CNC Laser emulation of the program (optional).

WireCut....

CNC Wire cutting emulation of the program (optional).

Update...

Update the current NC path emulation result with the current
content of the document file. You may modify the NC text lines
and press this function to update the NC path view.

Close

Close the right panel of path emulation.

The Options Menu
Options
Text Fonts...

Select text font and size for the document.

Colors...

Configure the colors used in the path emulation.

The Window Menu
Window
Cascade

Arrange document windows so they overlap.

Tile

Arrange document windows as non-overlapping tiles.

Arrange Icons

Arrange icons at the bottom of the window.

Close All

Close all document windows. You will be prompted to save the
file or not if one has been modified.

The Help Menu
Help
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Contents

Show help contents about this program.

About NcEdit...

Display program information, version number and copyright.
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Track Menu on the Text Panel
Refert to Text Editing on the Text Panel.

Track Menu on the Path Panel
Refert to NC Program Emulation on the Path Panel.

Track Menu on the Console Panel
If you click the right mouse button upon the Console Panel, a track menu will pop-up.
Each menu item is described in detail as follows:
Recording

Option to enable/disable the console messages recording. Check
to enable recording console messages to an internal text buffer.

Clear

Clear the content of the internal recording buffer.

Save

Save the content of the internal recording buffer to an external
text file.

Browse

Browse the content of the internal recording buffer.

<-Left side

Dock the console panel to the left of the document frame.

Right side->

Dock the console panel to the right of the document frame.

Both side

Dock the console panel to the bottom of the document frame.

Hide

Hide the console panel. You can call it out again via the menu
command [View.Text Console].

The ToolBars
A standard fix toolbar is provided on top of the frame window, as the picture given
below:

When the mouse pointer is moved at any one of these tiny buttons on the toolbar,
staying for more than 0.5 second, a bubble helping text will pop up next to the button
telling you what the button is all about. Most of the functionalities provided by the
toolbar buttons can also be found from the standard menu. So, they will also be
noted in the following description to the functions provided by the standard menu.
From left to right, a short description to each of these buttons are given below:
[File.New], Create a new NC program file.
[File.Open], Open an existing NC program file.
[File.Save], Save the active NC program file.
[File.Print], Print the active NC program file or the NC path emulation result,
depending on which is currently active.
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[Edit.Find...], Find the specified text.

[Edit.Find...], Continue to find the next specified text forward.
[Edit.Find...], Continue to find the next specified text backward.
[Edit.Cut], Cut the selection and put it on the Clipboard.
[Edit.Copy], Copy the selection and put it on the Clipboard.
[Edit.Paste], Insert text lines from Clipboard at current cursor position.
Zoom to view all the emulation paths on the drawing view panel.
Zoom in the current view on the drawing view panel by a factor of 2.
Zoom out the current view on the drawing view panel by a factor of 2.
Zoom to see the previous view on the drawing view panel.
Switch to use alternative language, if it is available.
Read on-line help.
Read information about this program.
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Text Editing on the Text Panel
The text editing capability of TCAM/NcEdit allows you to load in huge text files for
plain text editing. The maximum limit of text line number allowed in a single file is up
to 2,147,483,648 lines, and each line can have at most 250 characters.
TCAM/NcEdit provides the following elementary text editing capabilities:
!

Direct screen mode edit (move text caret around and do the text editing on the
spot).

!

Bookmark and direct line number locate.

!

Locate specific NC block by picking at geometry paths.

!

Find specific texts. See Finding Specific Text.

!

Replace specific texts. See Replacing Specific Text.

!

Cut, Copy and Paste texts.

!

Merge in external text file.

!

Save selected texts into external text file.

!

Remove the NC block's sequence number.

!

Regenerate the NC block's sequence number.

!

Formatted printout with multiple column control.

The text file is displayed and edited on the Text Panel of the document frame. The
current caret position of the text file in the current active document frame is
displayed in the status bar by its row and column numbers respectively.

Track Menu on the Text Panel
If you click the right mouse button upon the Text Panel, a track menu will pop-up, as
shown below:

Each menu item is described in detail as follows:
Restore Line

Restore the original text content of the current line. When you
move the caret to a new text line before making any modification,
its content will be saved into a temporary buffer. You can restore
it back after the text line is modified and before you move the
caret out of the line.
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Set Bookmark

Bookmark current line. A bookmark indicator will be placed
before the current line to indicate its position. When an emulation
path is present on the path panel window with Locate Mode
setting, then the corresponding NC code line to the located path
segment will also be bookmarked.

Goto Bookmark

Goto the line being bookmarked.

Switch Bookmark

Switch the bookmark between the current line and the last
bookmarked line.
Cut the selection and put it on the Clipboard. Note that you

Cut

can not cut the text if its total size is greater than 64 KB (a
Windows limitation). If you need to transfer part of the text lines
to another nc program file, use [File.Save Selected...] and
[File.Merge...] instead.
Copy

Paste

Copy the selection and put it on the Clipboard. Note that you
can not copy the text if its total size is greater than 64 KB (a
Windows limitation). If you need to transfer part of the text lines
to another nc program file, use [File.Save Selected...] and
[File.Merge...] instead.
Insert text lines from Clipboard at current cursor position.

Delete

Erase the current text in selection.

Select All

Select all text lines in the file.

Print...

Print the active NC program file. The Windows common
print dialog will pop up for you to conduct the printing action.

Print Preview

Display full pages of printouts.

Changing the Text Font
You can click the [Options.Text Font...] menu item to change the text font used on
the Text Panel.

Insert Mode vs. Overwrite Mode
When you key in a new character, there are two ways for TCAM/NcEdit to handle it:
!

Insert it in the text string pointed by the text caret, or

!

Replace the character in the text string pointed by the text caret.

The former is called Insert Mode and the latter, Overwrite Mode. You can toggle
between the two modes by pressing the <INS> key. In short:
Insert Mode
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New text characters will be inserted into existing text string,
instead of replacing the old ones. You can toggle between the
Insert Mode and the Overwrite Mode by pressing the <Ins> key.
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When the Insert Mode is effective, the text caret will be a blinking
vertical bar, and the status indicator "OVR" in the status bar will
disappear.
Overwrite Mode New text characters will overwrite the existing text string from the
text caret position. You can toggle between the Insert Mode and
the Overwrite Mode by pressing the <Ins> key. When the
Overwrite Mode is effective, the text caret will be a blinking
underscore, and the status indicator "OVR" in the status bar will
appear.

Text Caret Positioning
The text caret is either a blinking vertical bar under Insert Mode or a blinking
underscore under Overwrite Mode. It indicates a text position where new text
characters will be inserted, or where the text characters will be affected by the
subsequent commands.
There are several ways to change the text caret position:
!

!

Direct mouse cursor positioning -- You can directly set the caret position by the
I shape mouse cursor. Simply clicking the left mouse button and the new caret
position is set.
Pressing the cursor keys -- You can press the keyboard cursor keys to move
the text caret.

The following are the cursor keys that move the text caret:
Left

Move text caret backward by one character.

Right

Move text caret forward by one character.

Up

Move text caret upward by one line.

Down

Move text caret downward by one line.

PgUp

Move text caret upward by one page (text scroll down).

PgDn

Move text caret downward by one page (text scroll up).

Home

Move text caret to the beginning of current line.

End

Move text caret to the end of current line.

Ctrl/Left

Move text caret backward to the beginning of the last word.

Ctrl/Right

Move text caret forward to the beginning of the next word.

Ctrl/Up

Move text caret up one line and scroll the text down one line.

Ctrl/Down

Move text caret down one line and scroll the text up one line.

Ctrl/PgUp

Move text caret to the beginning line of file.

Ctrl/PgDn

Move text caret to the last line of file.
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Text Deletion and Restoration:
The following control codes will delete texts or restore texts:
Delete

If there are text being selected, they will be deleted; otherwise,
delete the character at text caret position.

BackSpace

Move text caret backward by one position and delete the
character at the text caret position.

Ctrl/Del

Delete all characters from text caret to the end of the line.

Ctrl/BackSpace

Delete all characters from text caret (exclusive) to the beginning
of the line.

Ctrl/F1

Restore current line content, same as [Edit.Restore Line].

Ctrl/Y

Delete current line and save it to Clipboard.

Splitting and Concatenation
The following control codes are used to split/concatenate text lines:
Enter

Split current line at text caret position and move the text caret to
the beginning of the newly split line.

Ctrl/Enter

Joint current line with the last line.

Ctrl/J

Joint current line with the next line.

Ctrl/M

Split current line at text caret position. The text caret does not
move.

Cut, Copy and Paste of Texts
You can follow the Windows convention to select a range of texts. Those texts in
selection will be displayed in reverse colors, so that they can be easily identified. You
can issue commands (from menu, toolbar button, or control codes from keyboard) to
cut/copy them to the system clipboard. You can also use the paste command (also
from menu, toolbar button or control code from keyboard) to paste in the texts from
the clipboard.
The following lists the keyboard control codes that are related to this subject:
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Ctrl/C

Copy selected texts to clipboard. You can also invoke this
function from [Edit.Copy] menu item.

Ctrl/V

Paste texts from clipboard. You can also invoke this
function from [Edit.Paste] menu item. Note that if there are texts
being selected, the texts will be replaced by the texts pasted from
the clipboard. Otherwise, the texts will be inserted from the
current text caret position.
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Ctrl/X

Cut selected texts to clipboard. You can also invoke this
function from [Edit.Cut] menu item. Cutting means copying and
then deleting.

shift...

Moving the text caret via the text cursor keys while the shift key is
being held down will select texts. For example, to select all texts
in the file, you can press Ctrl/PgUp first to locate the text caret to
the beginning of file, and then press Shift/Ctrl/PgDn to move to
the end of file and thus select all the texts.

Note that you can not cut/copy a piece of text if its total size is greater than 64 KB (a
Windows limitation). If you need to transfer a large part of the text lines to another
NC program file, use [File.Save Selected...] and [File.Merge...] instead.

Locating Specific Line
You can locate specific text line by
!

Using the Find command to locate text line by specific text string (see Finding
Specific Text),

!

Using the Goto command to locate text line by line number,

!

Picking the specific path segment from the Path Panel under Locate Mode.

Goto Line...
You can locate specific text line by specifying its line number. Just click the menu
item [View.Goto Line] or the row number field in the status bar, and then you will be
asked to specify the line number by the following dialog box:

A digit keypad will also pop up to help you enter the digit via the mouse pointer. The
current text line number will appear in the entry field for you to modify and reference.
You may enter the relative line number by prefixing a '+' character for forward
direction, or a '-' character for backward direction, to the number.
You have to press the <Enter> key to terminate the input. If you have specified the
relative line number, the field content will be updated with the resulting line number.
You have to press the <Enter> again to confirm it. Note also that if the entry is
incorrect, the field content will also be reset for entry again.

Locate Specific NC Block via Locate Mode
If the document file is an NC program file of which the program paths can be
extracted by the selected NC program Emulator, you can enable the emulator to
generate the path view on the Path Panel. You then can enter the Locate Mode, and
by picking at the specific path segment, you can locate its corresponding NC block
on the Text Panel. The NC block so located will be bookmarked automatically. This
feature is useful in modifying a complicated NC program with multiple program paths
in it.
See also Locate Mode Operation.
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Finding Specific Text
You can find specific text by clicking at the menu item [Edit.Find...]. The following
dialog window will pop up:

You can enter the text to find into the entry field of the combo-box, or select a
previous search text from its drop-down list. You can control the search direction by
the radio buttons from the Direction sub-group. You can specify to find the text string
of exact match by making a check in the "Match cases" check-box.
You can press the [Find Next] button to start the searching from the current text
caret position. If a match is found, the text caret position will be moved to the
beginning of the matching text string; otherwise, it will not be changed and a
message will be given.
The standard toolbar also contains the same combo-box and two helping buttons.
You can enter the text to find into this combo-box and press enter to start searching
forward from current caret position. Or, select a text from the drop-down list, and
to find the text forward or the
to find the text backward.
press the

Replacing Specific Text
You can replace specific texts with another texts by clicking at the menu item
[Edit.Replace...]. The following dialog window will pop up:

You can enter the text to find for replacement into the entry field of the combo-box
labeled as "Old text", or select a previous search text from its drop-down list. You
can also enter the text to replace with into the field of the one labeled as "New text",
or select a previous used text from its drop-down list.
You can control the search direction by the radio buttons from the Direction subgroup. You can also specify to find the text string of exact match by making a check
in the "Match cases" check-box.
If you are to replace all the occurrences of search strings, you may press the
[Replace All] button; otherwise, press [Find Next] to start the search and replace
operation from current text caret position.
Once a matching text string is found, the text caret will be positioned to its beginning
and the whole string will be high-lighted. A dialog box as below
16
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will pop up for you to specify one of the following actions:
!

!

Replace -- Replace the match string with the new text string and continue to
search for the next occurrence.
All -- Replace the match string with the new text string and continue to search
and replace automatically all the rest occurrences.

!

Skip -- Skip that match string and continue to search for the next occurrence.

!

Cancel -- Cancel the operation.

You may also re-specify the new text at this moment to replace with the matching
string.

Partial Saving and Merging
You can select a range of text lines and click the menu item [File.Save Selected...]
to save these selected lines of text to an external file. You will be asked to enter the
filename to save by the pop-up file window. Note that the selected texts are saved by
lines. That is, if a text line is partially selected, the whole line will be saved.
You can also click the menu item [File.Merge...] to merge in an external text file into
the current text file at the caret position.

Printing Text File
You can click the [Print...] or [Print Preview] menu item from the track menu to
print out the current text file. If the Text Panel is being active (you can see the caret
blinking), you can also click the same menu item from the [File] menu, or the
button.
You can setup the style of printing by the [File.Print Setup] menu item. See also
The Print Setup Dialog for details.
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NC Program Emulation on the Path Panel
There is only one built-in simple NC program emulator for use to extract the
programming paths from the NC file. The other sophisticated NC program emulators
are optional and are not available for the time being (though they are available for
the DOS platform).
To activate this built-in simple NC program emulator, click the menu item
[Emulation.Path...]. A simple dialog window, as shown below, will pop up.

You are asked to setup the initial machine state for valid NC program interpretation:

Program Mode
The NC machine may interpret the given coordinate in absolute or incremental
value, which can be specified by the G90/G91 G-code command from the NC
program. However, some programs may assume that the machine is in a certain
state without given any explicit command, and you will have to setup the correct
programming mode to extract the correct path geometries.

Dimension Unit
The coordinate values specified in the NC program may be in either metric (MM)
or English (Inch) unit, which can be specified by the G20/G21 G-code command
from the NC program. However, some programs may assume that the machine is
in a certain state without given any explicit command, and you will have to setup
the correct dimension unit in use to extract the path geometries with correct scale.

'/n' skip
There are ten optional skip controls. If the NC program has used such controls
and requires the correct setup of these controls, you can set them up in this group.
You can press the [Ok] button to proceed the path extraction, or press the [Cancel]
to cancel the operation.
If the text file contains a valid NC program, then the Path Panel will be opened and
its program paths will be drawn within the panel. Otherwise, a message of "Invalid
NC Program File" will be given.
The built-in NC program path emulator recognizes only the following commands:
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!

G00 -- Fast tool move.

!

G01 -- Linear interpolation tool move (cutting).
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!

G02 -- Circular interpolation tool move (cutting).

!

G03 -- Circular interpolation tool move (cutting).

!

G17 -- Setting X/Y plan movement.

!

G18 -- Setting Z/X plan movement.

!

G19 -- Setting Y/Z plan movement.

!

G20 -- Setting English (inch) unit.

!

G21 -- Setting Metric (MM) unit.

!

G90 -- Setting Absolute programming.

!

G91 -- Setting Incremental programming.

!

G92 -- Setting coordinate system.

All other command codes are ignored.

Track Menu on the Path Panel
If you click the right mouse button upon the Path Panel, a track menu will pop-up, as
shown below:

Each menu item is described in detail as follows:
Zoom All

Zoom to view all the emulation paths on the drawing view
panel.

Zoom In

Zoom in the current view on the drawing view panel by a
factor of 2.

Zoom Out

Zoom out the current view on the drawing view panel by a
factor of 2.

Zoom Previous

Zoom to see the previous view on the drawing view panel.

Locate Mode

Enable/Disable NC block Locate Mode. See Locate Mode
Operation for details.

Plan View

Change the view to 2-D plan view.

3D-View

Change the view to 3-D view.
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Rotate the current 3-D view point. In fact, as long as the drawing
view is in focus, you can press the cursor key to rotate the 3-D
view point any time. See Rotating the 3-D view on the Path Panel.
Copy the drawing view to the Clipboard.
Export the emulation result of the NC program file in various
kinds of drawing file format. You will be asked to enter the name
of the drawing file to export from the pop-up file window. You can
select one of the following drawing formats from the file-type
selection box:
WRK -- TwinCAD Work Drawing File.
DWG -- AutoCAD Drawing File (R10/R12).
DXF -- AutoCAD Drawing Exchange File (ASCII/Binary).
WMF -- Windows Meta File.
BMP -- Windows Bit-Map File.
GIF -- CompuServe Graphic Interchange Format.
PCX -- Paint Brush Picture File.
TIFF -- Tagged Image Format File.

Print...

Print the NC path emulation result. Windows common print
dialog will pop up for you to conduct the printing action.

Print Preview

Display full pages of printouts.

Update...

Update the current NC path emulation result with the current
content of the document file. You may modify the NC text lines
and press this function to update the NC path view.

Close

Close the right panel of path emulation.

Changing the view on the Path Panel
There are several ways to change the view on the path panel.
!

!
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You can move the scroll bar to pan the current view.
You can change the geometry extent of the view by clicking at the left mouse
button directly to designate a corner of the new extent, and then click again for
another corner while opening a rectangle box of the view extent.

!

You can click the
button, or the [Zoom All] menu item from the track
menu, to view the whole paths in the window.

!

You can click the
button, or the [Zoom In] menu item from the track menu,
to enlarge the current view by a factor of 2.

!

You can click the
button, or the [Zoom Out] menu item from the track
menu, to shrink the current view by a factor of 2.

!

You can click the
button, or the [Zoom Previous] menu item from the
track menu, to restore the last view in the window.
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You can click the [Plan view] menu item from the track menu to see the paths
in 2-D plan view.
You can click the [3-D view] menu item from the track menu to see the paths in
3-D view.

The track menu can be activated by clicking the right mouse button upon the Path
Panel.

Rotating the 3-D view on the Path Panel
Whenever the focus is on the path panel, you can press the following cursor keys to
rotate the 3-D view point under the 3-D view mode:
Left

Rotate about the +Z axis of the modal space CCW by 10
degrees.

Right

Rotate about the +Z axis of the modal space CW by 10 degrees.

Up

Rotate about the +X axis of the projected space CCW by 10
degrees.

Down

Rotate about the +X axis of the projected space CW by 10
degrees.

PgUp

Combining effects of Top and Right keys.

PgDn

Combining effects of Down and Right keys.

Home

Combining effects of Top and Left keys.

End

Combining effects of Down and Left keys.

You can click the menu item [Rotate] from the track menu to set focus on the Path
Panel and then use the above cursor keys to rotate the view. The track menu can be
activated by clicking the right mouse button upon the Path Panel.

Locate Mode Operation
You can enable Locate Mode by clicking the [Locate Mode] menu item from the
track menu. When the Locate Mode is effective, the cursor in the Path Panel will be
a tiny target box.
Under Locate Mode, you can
!

Identify the geometry of a specific path segment,

!

Locate corresponding NC block on the Text Panel,

by picking directly on the path segment with the target box. The segment being
identified will be indicated by two small indicators on its both ends:
Square

The starting point of the segment.

Triangle

The ending point of the segment.
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The corresponding NC block that produces this segment will be located in the Text
Panel with bookmark, and the geometry of the segment will be reported on the
Console Panel.
After locating a specific segment, you can travel along the path by pressing
PgUp

Backward one segment.

PgDn

Forward one segment.

You can also locate a corresponding path segment from the Text Panel by directly
setting bookmark on a specific NC block, under Locate Mode.

Exporting Emulation Results
You can export the emulation result (such as program paths extracted by the built-in
NC program emulator) by clicking the [Files.Export...] menu item. You can export
the result in various kind of drawing file format.
You will be asked to enter the name of the drawing file to export from the pop-up file
window, and You can select one of the following drawing formats from the file-type
selection box:
!

WRK -- TwinCAD Work Drawing File.

!

DWG -- AutoCAD Drawing File (R10/R12).

!

DXF -- AutoCAD Drawing Exchange File (ASCII/Binary).

!

WMF -- Windows Meta File.

!

BMP -- Windows Bit-Map File.

!

GIF -- CompuServe Graphic Interchange Format.

!

PCX -- Paint Brush Picture File.

!

TIFF -- Tagged Image Format File.

Note that except for CAD drawing files (WRK/DWG/DXF), all image drawing file
exports will require you to specify further the resolution, size, pen width and color
type of the image by the dialog window as shown below:

The following describes these screen items in details:
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File Format
The first field display the name of the selected output file format, which is not
allowed to change in current version. The second field display the current selected
sub-format. You can click it and select one from the drop-down list.

Orientation
This field is now fixed as "Normal".

Resolution
You can specify the output resolution in units of DPI.

Scale Factor
The scale factor of the output image size in terms of the plotting width with respect to
the size of the path geometry in the modal space (assuming in units of MM).
Changing this values will change the current plot height and width setting.

Plot Width
The width of the image size based on the output resolution. It can be specified in
Inches or MM, depending on the current unit selection. You can select the unit by
clicking at the unit suffix to this field. Changing this field will change the scale factor
as well as the Plot Height.

Plot Height
The height of the image size based on the output resolution. It can be specified in
Inches or MM, depending on the current unit selection. You can select the unit by
clicking at the unit suffix to this field.

Pen Width
There are 16 pen width setting for the 16 pen colors. The pen width is given in units
of MM. The effective pen width will be calculated based on the current setting of
output resolution. A pen width of 0 means the finest pen.

Current View
Option check box. Check to create the image of the current view only; otherwise, the
whole view of the drawing paths will be output.

Plot With Frame
Option check box. Check to create the image with a boundary frame.

Printing Emulation Results
You can click the [Print...] or [Print Preview] menu item from the track menu to
print out the current view on the Path Panel. If the Path Panel is being active (you
have mouse click in it), you can also click the same menu item from the [File] menu,
button.
or the
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You can setup the printing page by the [File.Print Setup] menu item. See also The
Print Setup Dialog for details.

The Print Setup Dialog
The following dialog window will pop up when you activate the menu item [Print
Setup...] from the [File] menu.

The print setup dialog box let you
!

Set the margins on printed pages.

!

Set the number of text columns on the printed pages.

!

Specify the text for headers and footers on each page.

!

Specify the font used for the printed text by the [Font] button.

!

Setup the printer by the [Printer] button.

Fonts
You can choose to use the same font as that used in the screen display by checking
the option: "Use same screen text font". Or, press the [Font] button to specific a
text font used for the printout. The name and size of the effective text font to be used
in the printout will be displayed in the dialog box.

Headers & Footers
There are two headers and footers setting. One for the text document printout and
the other, for the drawing view printout. The header will be printed at top and outside
of the printing frame, aligned with the left margin by default, while the footer, at the
bottom and also aligned with the left margin by default.
The contents of the headers and footers can contain special character sequences to
insert specific informations or to change the text alignment. These supported
character sequences and their effects are described below:
&L or &l
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Left aligned. All the text string after this sequence will be left
aligned in printout, until the next sequence that changes the
alignment. This is an initial default.

TCAM/NcEdit for Windows V1.0

NC Program Emulation on the Path Panel

&C or &c

Center aligned. All the text string after this sequence will be
center aligned in printout, until the next sequence that changes
the alignment.

&R or &r

Right aligned. All the text string after this sequence will be
center aligned in printout, until the next sequence that changes
the alignment.

&f

Full path name of the document file in printing.

&p

Page number of current printing page.

&P

Total number of pages will be printed.

&S or &s

Starting line number of current printing page.

&e

Ending line number of current printing page.

&E

Total line number of the document file in printing.

&T or &t

Current system time.

&D or &d

Current system date.

Margins
You can specify the left, right, top and bottom margins of the printout in units of inch.

Column Control
You can choose to print the file in single column, double column, or multiple column
where you can specify the column number directly. Note that each text line will not
be wrapped around in a text column if it is too long.
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The DNC Data Transmission
TCAM/NcEdit allows you to transmit or receive the content of the current text file
document (such as an NC program) through a COM port to an external device (such
as the NC controller), using ISO, EIA or ASCII codes. You can access
simultaneously up to 8 I/O devices through the system COM ports. The details of the
I/O properties for each attached devices can be setup individually. See Setting up
the I/O Devices.
If the text file being transmitted is an NC program file and the Path Panel is also
available (through NC emulation), back-plotting of the NC program during
transmission will be conducted. You will see un-transmitted portion of the paths
drawn in gray color, while those transmitted in ordinary colors. This is very helpful in
monitoring the progress of the Direct NC machining.

Setting up the I/O Devices
Before you can conduct any DNC data transmission, you need to setup the I/O
devices. You can add new devices by the function from the pop-up menu item
[Transmission.Add New Devices] and modify the device setup by that from the
menu item [Transmission.Modify devices...].
Both functions will enter a dialog box like that shown below:

The following describes these setup in details:

Device Name
The device name is the name you give to identify the device. It can be any string. It
will appear in the list of devices (as a pop-up sub-menu) for you to choose for the
[Transmission.Send to], [Transmission.Receive from] and [Transmission.Modify device...]
function.
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For a new creation of device setup, this field is empty, and you will be asked to
specify the name of the I/O control file to store with these parameters, provided that
the I/O control file is also not specified yet.

I/O Control File
This is the true pathname where the I/O setup parameters are stored. The format of
the I/O setup file is compatible to those old I/O files used for the DOS version. You
can select an existing I/O setup file to setup a device.
For a new creation of device setup, this field is empty, and you will be asked to
specify it after you has specified the name of the device. You can pick at this field to
re-specify the full pathname. It will let you overwrite any existing I/O file.
If you want to use an existing I/O file, press [SelFile] button to select it.

Input Control
The Input Control group contains data receiving specific parameters:
Dev. Control

Option Selection. Click to select from the drop-down list one of
the four type of controls; namely, they are "Master", "Slave", "No
Control" and "Heidenhain". See Basic Transmission Device
Control section.

Start of Rx.

String, specifying to start receiving data and store them into the
file buffer after the particular text string is received. Click to enter
the text string. If this string is empty ("[None]"), then all data will
be stored into the file buffer upon receiving.

End of Rx.

String, specifying to stop receiving data and terminate the
transmission as soon as the particular text string is received.
Click to enter the text string. If this string is empty ("[None]"), then
the transmission will be stopped only upon a time-out error
happens or upon a user explicit stop request.

Time out.

Integer, specifying the time out constant in unit of second.

Note that the control codes may be entered indirectly to the string in the form of "^x".
For example, the <CR> code is "^M", and the linefeed code is "^J".

Output Control
The Output Control group contains data transmitting specific parameters:
Dev. Control

Option Selection. Click to select from the drop-down list one of
the four type of controls; namely, they are "Master", "Slave", "No
Control" and "Heidenhain". See Basic Transmission Device
Control section.

Leading Mesg.

String, specifying to generate the memo string for tape punching,
effective only when the device control type is set to "Master". All
the characters in the string will be output in a large font that can
be read directly by people checking the tape. The character font
is in 5 x 7 hole matrix.
Special function codes are provided for the memo string output:
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"?D"

The host will automatically generate the
system date in the format of 'Fri Aug 3,
1986'.

"?d"

The host will automatically generate the
system date in the format of '1986/08/03'.

Start of File

String, specifying additional text string to transmit before
transmitting the file.

End of Block

String, specifying additional text string to transmit after each NC
block is transmitted. If this parameter is not empty, the <EOB>
code will not be sent automatically. The string must contain the
appropriate <EOB> code. However, if it is empty, the standard
<EOB> code will be sent automatically after each NC block.

End of File

String, specifying additional text string to transmit after
transmitting the whole file.

Send Delay

Integer, in unit of ms, specifying to delay the data transmission by
the specific amount of time after each character is sent.

Spacing

Integer, specifying automatic paper tape feeding count in terms
of holes, effective only when the host is in "Master" mode. If this
setting is not zero, then before punching the leading memo string,
the start of file, and the NC file body, the host will command the
puncher to feed the paper tape for the specific number of holes.
During the course of the tape punching, if the next two codes to
be punched from an NC block match with the codes set by the
parameter "Spacer", then the host will ignore the rest of that NC
block and automatically generate the specific paper tape feed.

Spacer

Integer, non-zero value specifying the spacer code used for the
automatic paper tape feeding. The default code of this parameter
is 3A3Ah in hex or '::' in ascii. The entry is in hexadecimal value.

TV-Fillet

Integer, non-zero value specifying the fillet code of the TVchecking. If the controller has TV-check option and the option is
on, you should set this parameter to a proper value.
The fillet value is the code used to add into the NC block to make
the total character count even. It must be a code acceptable and
meaningless to the controller. Usually, a space code (0020h in
ascii) or a <CR> code (000dh in ascii) will satisfy this requirement.
It depends greatly on the type of controllers.
Setting a zero to this value, will disable the host in generating the
TV-check code from the NC block. If the null code (zero value) is
to be used as the fillet code, then enter the 100h to this
parameter.

Screen Output

Option selection, specifying how the data transmission be
monitored from the screen. You can select one of the following
configurations:
Paging -- The text lines will not be scrolled up when the screen is
full, but the screen will be cleared and the text lines start
displaying from the top of the screen.
Scroll -- The text lines will be scrolled up when the screen is full.
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TapeOut -- An tape punching simulation is conducted to the right
of the screen. This is a compatible feature to the DOS version.
Remove Space

Option selection, specifying whether to remove the space
characters from the NC block during transmitting. If you choose
"Yes", all the blank characters will be ignored during transmission.

Connection
The Connection group contains parameter setup that is related to the
communication port, as described below:
Baud Rate

Integer value entry, specifying the communication baud rate. This
is a direct value entry. Most commonly used baud rates are 300,
600, 1200, 2400, 3600, 4800, 9600, and 19200.

Parity

Parity status selection from "EVEN", "ODD" and "NONE".

Stop Bits

Selection between "1" or "2".

Word Length

Selection among "5", "6", "7" and "8".

Code Used

Selection among "EIA", "ISO" and "ASCII".

Com. Port

Communication port, selection from a list of available ports.

Auto Xon/Off

Turn the Xon/Xoff transmission protocol On/Off.

Note that the parity of the EIA code is even. So If you set 8 bits of EIA code with
"NONE" parity, it is equivalent to 7 bits of EIA code with "EVEN" parity setting. Also,
the parity of the ISO code is odd. So if you set 8 bits of ISO code with "NONE" parity,
it is equivalent to 7 bits of ISO code with the "ODD" parity setting.

The [SelFile] button
You can select an existing I/O setup file to use by pressing the [SelFile] button.

Basic Transmission Device Control
There are four type of basic transmission device controls supported by
TCAM/NcEdit:
Master

The host (TCAM/NcEdit) will configure itself as a master
controller, and the external device, as a slave device. You must
choose this type of control if the external device is a paper tape
puncher or tape reader. The host will automatically emit control
codes to control such devices.

Slave

The host will configure itself as a slave device, and the external
device, as a master controller. In such a configuration, the host
will act like a tape puncher in receiving data and like a tape
reader in transmitting data. It will accept and interpret the device
control codes emitted by the external device.

No Control

The host will be in an equivalent position to the external device,
and will not wait for device control codes from it, nor will the host
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send the device control codes to it. It will configure itself as an
ordinary communication unit only.
Heidenhain

The host will assume that the external device is a HEIDENHAIN
type controller and will follow the HEIDENHAIN's special
'Transfer Blockwise' protocol.

Sending Data to External Devices
To send the current text file document to the external devices, click the device name
under the [Transmission.Send to...] sub-menu. TCAM/NcEdit will start sending
data from the bookmarked line if the option [Transmission.From Bookmark] is
checked; otherwise, it starts sending from the first line in the file.
The Console Panel will appear if it is being hidden. It is used for general message
output and receiving code monitoring from the external device. All codes being
transmitted will be locally echoed on the Text Panel. Depending on the I/O property
setup, the Text Panel will scroll up for new line or clear the whole page if the echoed
text line has reached the page bottom. A progress indicator is provided at the top of
the Text Panel.
If the option to generate a tape simulation output is being enabled, which is a part of
the I/O property setup, it will appear to the right of the Text Panel. This feature is
supported for DOS version compatibility reason and the reason for its presence in
the DOS version can be traced back to more than a decade ago when everybody
used tapes.
If the text file being transmitted is an NC program file and the Path Panel is also
available (through NC emulation), back-plotting of the NC program during
transmission will be conducted. You will see un-transmitted portion of the paths
drawn in gray color, while those transmitted in ordinary colors. This is very helpful in
monitoring the progress of the Direct NC machining. See Back-plotting of the NC
Tool Paths.
During data transmission, you can pause it or terminate it at any time. See Pause
the Data Transmission and Stop the Data Transmission.
At the end of the transmission, TCAM/NcEdit will report in the Console:
End of Transmission: nnnn Chars Sent in mmmm Sec.

If the data transmission was terminated by interruption, the last text line to be sent
will be bookmarked, and the option to send "From Bookmark" will be checked
automatically. This would be helpful in re-sending the data after interruption.

Back-plotting of the NC Tool Paths
If the text file being sent is an NC program file of which the program paths can be
extracted by the selected NC program emulator, back-plotting of the NC program
paths during data transmission is supported.
Back-plotting means to plot out the NC program paths as the corresponding NC
blocks are transmitted to the controller for direct execution. The operator can
observe the progress of the NC machining from the screen, instead of going to the
machine side.
You can activate the back-plotting by firstly entering the emulator to produce the
program paths on the Path Panel, and then do the data transmission thereafter. In
fact, as long as there is a Path Panel available, which must be opened by the
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emulator, the data transmission will always generate the back-plotting in it. So, you
can turn on the back-plotting by re-entering the emulator and turn it off by closing the
Path Panel, during the data transmission.

Receiving Data from External Devices
To receive a text file document from the external devices, click the device name
under the [Transmission.Receive from...] sub-menu. The current text file content
will be clear for the new coming data.

Pause the Data Transmission
During the data transmission, you can suspend it by clicking at the
[Transmission.Pause] menu item, or the [Pause] item from the track menu.
Pressing space bar will also pause the transmission; however, it is not
recommended to do so, since you have to make sure that the document frame is
being active and the transmission module can receive your keyboard input.
When the data transmission is being suspended, you will see a tiny dialog box
appeared with a blinking message "Pausing" in it. You can take one of the following
actions:
Release

You can release the suspension by pressing the <Enter> key
from the keyboard. The blinking message will disappear and the
data transmission continue.

Terminate

You can terminate the data transmission by pressing the <ESC>
key from the keyboard, or by clicking the right mouse button, or
by clicking at the [Stop] menu item. A confirmation dialog box
will pop up for you to confirm the action.

Step

You can press any other key or click the [Pause] menu item
again to step the data transmission. About 10 characters will be
sent for a step.

You have to take an action whenever you pause the data transmission.

Stop the Data Transmission
You can stop the data transmission by clicking at the [Transmission.Stop] menu
item or the [Stop] menu item from the track menu. A confirmation dialog box will
appear for you to confirm the action.
If you confirm to stop the transmission, it will be terminated only after a whole line is
sent provided that there is no I/O error. The next unsent text line will be bookmarked,
and the option to send "From Bookmark" will be automatically checked. This would
be helpful in re-sending the data after the user interruption.
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